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AgentCOM is a desktop application that works on any Windows operating system. The purpose of this application
is to make day-to-day work easier for agents in Call Centers. It enables the agent to easily answer the call, reject it,
transfer to another number, or interact with a CRM which can be shown to the agent.
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Chapter 1. Configuration

When AgentCOM starts for the first time, the manager/administrator will have to set up the server, extension, and
password to which AgentCOM will send calls. Clicking on File->Configuration menu will bring up configuration
dialog which the manager can use to set AgentCOM preferences.

@:B Tip
Password that is used for accessing the configuration is the current date in this form: DDMMYYYY

General

AgentCOM - Configuration x|

General |PmFile | URL Popup | Other | 1DG Partal |

[v Make AgenkCOM primary application

v Ering AgentCOM ko fronk on incoming call

] 4 iZancel

Table 1.1. General

Field
Make AgentCOM primary application

Bring AgentCOM to front on incoming call

Description

Whether to set AgentCOM as always on top and not
minimizable

Should incoming calls bring AgentCOMs windows to the
front

Profile




Configuration

AgentCOM - Configuration x|

General Profie |URL Popup | Other | 1DQ Portal |

SErver:
10,1.0.124

Extension:
1000

Exkension's secret:

bt bt
Dialer port:
10002
(] iZancel
Table 1.2. Profile
Field Description Example
Server: Enter the IP address or hostname of 110.1.0.124:5037 - This will tell
PBxware to which to connect. AgentCOM to login to this IP using
port 5037
Extension: Extension number (phone) which is 1002
going to be used to log agents to
Extension's secret: Password that is used for that $#v2tr2232!"Sefwe
extension
Dialer port: If the dialer will be used within 10002
AgentCOM, set its port here

@B Tip
Extension that is going to be used must have "In Manager Proxy" option turned ON in PBXware GUI

URL Popup




Configuration

AgentCOM - Configuration x|

General | Profie URLPopup | other | 1DQ Portal |

v Show URL Popup kab

LIFL opkions:

|Use URL specified in AgentCOM |

URL (% CALLERID®: macro can be used):

Iwww.bicnmsystems.cnm

(] iZancel

One of the features that takes up most of the main AgentCOM screen is URL Popup, which can actually show a
webpage depending on the settings that you set here. It can show the webpage of your favorite CRM to help the
agent in his or her job, such as searching for details on the caller, etc.

Table 1.3. URL Popup

Field Description Example
Show URL Popup tab Whether to show URL Popups at all ' Checkbox
URL options: Use URL specified in AgentCOM or |Use URL specified in AgentCOM

URL specified in the "Queue URL"
field in a queue in PBXware interface

URL (%CALLERID% macro can be |Which URL to show in a popup for If using a CRM which can present

used) every call information about the caller, you can
use %CALLERID% macro to send
the CallerID to the CRM so that it can
present the according information to
the agent

Other




Configuration

AgentCOM - Configuration

zenetal I Prafile I URL Popup  Cther |IDQ Portal I

[v Enable Hangup Butkon

[+ Enable Reject Button

v Enable Transfer Bukkan

[¥ Enable I¥R Transfer Butkon

v “Write CurrentZall, xml File

iZancel

Table 1.4. Other

Field
Enable Hangup Button

Enable Reject Button
Enable Transfer Button

Enable IVR Transfer Button

Write CurrentCall.xml file

Description

Whether to enable the hang-up button for the agent to
use

Whether to enable the reject button for the agent to use

Whether to enable the transfer button for the agent to
use

Whether to enable the IVR transfer button, which, when
pressed, asks the agent to enter a number. That number
will be used as a context to which the caller will be sent
to. Custom AGI script on the PBXware will then decide
what to do with the call

Whether to save the CurrentCall.xml file for the current
call taken by an agent

Tip

Q

CurrentCall.xml file is in the following form:

<?xm version="1.0"?7>

<CurrentCal |l >

<Cal | Ti me>30. 07. 2010 15: 49: 13</ Cal
<Cal | er Number >104</ Cal | er Nunber >

| Ti me>

<Cal | er Name>Ki ax Test </ Cal | er Nane>

<Di recti on>l nbound</ Di r ecti on>
<Agent >1000</ Agent >

10




Configuration

<Agent Name>Deni s Test </ Agent Nane>
<QueueName>Deni s</ QueueName>

<QueueNumber >106</ QueueNumber >

<Uni quel D>1280497695. 52</ Uni quel D></ Current Cal | >

IDQ Portal
x|

zeneral I Profile I LRL Popup I Cther DG Portal I

[v Enable IDG Portal inkegration

1D Porkal application path:

v Use AgentCOM username and password For autharization

Isernane:

Passwiord:

Ik iZancel

Set the parameters used for integration with the IDQ Portal phone database software.

Table 1.5. IDQ Portal

Field Description

Enable IDQ Portal integration Whether to enable integration with the IDQ Portal phone
database

IDQ Portal application path: Path for the IDQ Portal application

Use AgentCOM username and password for Whether to use AgentCOM's username and password o

authorization set new ones here

Username: Username for IDQ Portal authorization

Password: Password for IDQ Portal authorization

11



Chapter 2. Features

The first time you start the AgentCOM application, you will need to login either as a static agent or a dynamic one.

Profile:

IDeFauIt j

Agent number:

|1nnn

FIM:

I****

agent bvpe:
ICaIII:nan:k Agent j

v Enable Dialer

Log In |
Table 2.1. Login window
Field Description Example
Profile: Select a profile to use for login. The

profile can be defined as a simple
TXT file which has a name

profileX.txt where X is a number. [ back-of fi ce]

server=192.168.0. 12
user name=6502
secr et =4TRZBG65G

Agent number: Agent number used for logging in 1000
PIN: PIN number of the agent, supplied 7474
above
Agent type: Depending on what you select here, | Static Agent

you will be a callback agent which
means that on every queue call,
system will call your extension. If you
chose Static Agent, your phone will
be called and you will listen to music
on hold until the call is put through.

Active Call window

12



Featu
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The Active Call window shows information about the caller and possible actions that the agent can take.

) Available

Call Status:
Duration:
Unique Call ID:
(Jueue:

accepk

Denis (Mr: 1000), Callback Agent @

1005 {John Crichton) NOT READY

answered

0o:0

1262294840, 1
Quele-1 (1001

> Transfer

3:04

@ INR. TransFer |

The top of the active call window shows the Agent's name and number, whether it is a static or callback agent, and
his availability. The circular red-white button that you see on the top right is used to send an assistance request to
the supervisor(s) that are monitoring agents with AQMON.

Table 2.2. Information about call

Field
1005 (John Crichton)

NOT READY

Call Status:

Duration:
Unique Call ID:

Queue:

Description

As seen in the example, this will show the full CallerID of
the caller.

This is a button which agent can use to put himself in not
ready state so his client wouldn't receive any calls during
that time. When agent click on NOT READY button it will
change label to a timer which will show the time that
agent spent as not ready. When you click on it again,
agent will start receiving calls again.

Status of the incoming call, whether it is ringing or
answered.

Duration of the call in question.

This field shows the unique call ID as seen in PBXware
for current call.

This field shows the name and number of the queue
from which the call came.

Table 2.3. Control buttons

Button
Accept

Description

When AgentCOM is used in conjuction with PBXware
dialer, and the dialer is using the "preview" strategy, this
option is available. The dialer will send the next call that
will be made and the agent will be able to approve

13




Features

Button Description

clicking on Accept or reject using the Reject button (ex
Hang-up button)

Hangup/Reject The Hang-up button, as its name suggests, is used to
hang-up the call. The reject button is used to reject a call
coming from Dialer.

Transfer Transfer an incoming call to some other number

IVR Transfer This button transfers the call to a given number/context
which is already created on PBXware. On PBXware,
there is an AGI script which will then proceed with the
call as the customer programmed it to.

Queue information

The queue informaton tab shows basic information about queues of which the agent is a member.

QUeEs I Campaigns I

Queue Marme Members/Logged In | ‘Waiting
Queue-1 (1001 21 1
Queus-Z (1006) 52 1]

Table 2.4. Queue information

Field Description

Queue Name This row show queue names and numbers. Of course it
will show only queues of which the agent is a member.

Members/Logged In Shows the total number of members of the queue and
the number of logged in members.

Waiting Shows the number of calls in the queue which are
waiting to be answered.

Gia Tip
Campaigns tab shows the name and number of members inside a campaigns if AgentCOM is used in
conjuction with PBXware dialer.

Messages

The messages section is used to show messages that supervisors send to agents. Also, you have the ability to
send a message to your supervisor if you need to. The top of the section has arrows pointing left and right which
are used to browse through the messages that the agent has received.

14



Features

Messages
{@ MESSAGES
Displaying: 44 Cl>
iy ALERT

Sender: Operator (awg 20, 16:23)

There are three unanswered calls in
OQueue-2

Send message I

The middle of the section shows the type of the message and message contents.

If you click on the Send message button, you will have the ability to choose which supervisor you want to send a
message to, and then type the message you want to be sent. The supervisor will see the message and any
response from him/her will be seen as a new message here.

Integrated Web browser

The Integrated Web browser is used to show any information that the agent requires or to show the information
from a CRM which is usefull if you want to pull information about the current caller or anything else call-regarded.
The integrated browser uses your system's Internet Explorer as the engine.

15



Features
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Chapter 3. Main menu

This chapter describes functionality of every single item from main menu.

File

Table 3.1. Items in File menu

Item Description

Log Out
agent using it.

Configuration

When you click here, the application will log out the

This will bring up the configuration dialog which is
described in Configuration

Exit Exits the application

View

Show tabs in separate Window

This option will show the URL popup tabs in separate windows as per the screenshot.
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Main menu

Show tabs in AgentCOM Window

This is the default option in AgentCOM where the URL popup tabs are shown in the same window as other parts of

the application.
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Hide tabs

This option will hide the URL popup tabs and show only the main part of the application.

Skin

AgentCOM has three skins that agents can use:

» Skin 1 is the default skin that you see when you run the program.

» Skin 2 changes the look of main part of the application. Active call and queue info show less information while
messages are not seen (screenshot below)

» Skin 3 hides AgentCOM altogether where the agent will only receive a popup from the tray bar when a call

comes in.

When the application is in Skin 2 mode, it looks like this:
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Main menu
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When application is in Skin 3 mode, it will hide and show only an icon in the tray from which the user will get a
popup which natifies him of incoming calls:

Inbound Call

Queue: Queue-1 {1001)

CallerID: 1005 {John Crichton)

Message History

Message History lists all of the messages that the agent received from the supervisor(s).
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Main menu

Messaqge History il

From Date) Tirme
avg 20, 16:23 There are three unanswered calls in Queus-2
Qperator Information awg 20, 16:23 There are bwo unanswered calls in Queue-1
Qperator Information awg 20, 16:22 Please stay on the phane
Qperator Information awg 20, 16:22 Mo problem
Message:

There are three unanswered calls in Queue-2

Close
Table 3.2. Message History
Field Description
From Which supervisor sent the message
Message type Whether the message is an alert, warning, or info
Date/Time Date/Time when the message was sent
Message This row shows the first few words of the message that
the agent received
Message: Complete text of the selected message

Network->Debug Info

This menu will bring up a new window with two tabs containing debug output from the Manager and Dialer.
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Main menu
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This window contains one menu which has three items. Those items will allow you to copy the contents of the
window to the clipboard, clear the contents of the window, or close it altogether.

Help->About

This menu shows the about window.

About . {

ﬁ AgentCOM
Werzion 2.00

Copyright [c] Bicom Systems 2008

Uzing P Prosy semvice

ok |
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